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Product description 
 

� What is EEGfree? 

EEGfree is the newest light and sound instrument, which consists of a unique one 

body of a light glasses and a controller produced by DreamFree Inc. It enhances 

concentration for studying and helps relieve tension, exhaustion, and stress. It has an 

easy operation for everyone to maintain his or her best mind condition. 

 

� What is EEG? 

It stands for Electroencephalogram that is used in hospitals, laboratories and 

colleges which study Neuro-Technology as a professional. It is simply called “Brain 

Wave.” 

 

� Principles of EEGfree 

 

FFR (Frequency Following Response) 

: It refers to the brain’s natural tendency to mimic or to resonate the same 

frequencies generated by outside stimuli. This is the process light and sound 

instruments utilize for entraining the brain 

 

The signal of Inducing EEG 

: A signal to induct a specific brain wave, applying FFR 
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� Effects of EEGfree 

Use Effects 
Study Increasing learning efficiency of students 
Sleep Providing deep sleep and eliminate fatigue 

Concentration Increasing training efficiency for sportsmen who need mental 
concentration 

Relaxation Relieving stress and anxiety 

 

� Features of EEGfree 

- One-bodied product (Controller + glasses) 

- Seven basic EEG signals + downloadable EEG signals (�) 

- Seven levels of sound and light intensity 

- One AAA size battery 

- Auto shut off function after playing a mode 

- Compatible with PC, cassette and CD player 

- Various EEG signals downloadable from website 

(www.eegfree.com) 

- Various music offered for musical therapy 

- Modernized design and light weight  

 

� Types of EEG 

Wave State of mind and body 

Gamma - 35 Hz (ã)  Unstable, hot-tempered 

Beta - 13~34Hz (â)  Active, concentrated  

Fast á - 11~12Hz  Concentrated  

Middle á - 10~11Hz  Maximum concentration and memorization 
 Lucid Mental State, Reduced Tension 

Alpha- 
8~12 Hz(á) 

Slow á -8~9Hz  Meditative state 

Theta - 4~7Hz(è)  Light sleep, telekinesis 

Delta - 0.5~3Hz(ä)  Deep sleep 
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� Functions by mode 

Mode Function Status Operating 
time 

M1 / 
Concentration 

* Enhancing concentration 
before learning 

* Converting exited 
 condition into stable status 
* Inspiring desire for learning  
* Relieving fatigue caused 

by insufficient sleep 

* Relaxed 
* Having a clear head 

15 min 

M2 / Study * Concentration-supporting 
* Activating the brain 
functions 
* Sharpening the memory 
* Enhancing the memory &  

concentration 

* Use sound alone while learning) 
* Good concentrating  
* Unable to hear external sound 
clearly while concentrating on 
learning  
(Turn down the volume and adjust 
unused optic glasses to the lowest. 
Then it does not operate.) 

60 min 

M3 /  
Study with tape 

* Supporting to concentrate 
* Enlightening intelligence & 
sharpening understanding 

* Use sound alone while learning 
* Good concentrating  
* Unable to hear external sound 
clearly while concentrating on 
learning  
(Set the Tape Recorder Output to 
the EEG Input. After operating 
EEGfree, adjust LED to the lowest 
and the volume of sound enough to 
be mixed with teaching ads sound, 
in order not to be interfered with 
learning.) 

60 min 

M4 / Relaxation * Stabilizing excited state of 
mind 

* Getting rid of fatigue 
* Relaxing 

* Feeling relieved 
* Feeling free from confused thinking 
& recharged the spirits 

16 min 

M5 / Meditation * Leading to meditation in a 
short time 

* Lucid mental state 16 min 

M6 / Vitality * Helping cope with 
enervation and stress 

* Motivated & relieved from 
displeasure 

10 min 

M7 / Sleep * To be used when the deep 
sleep is needed 

* Falling into a deep sleep 30 min 
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Structure & components 
 

 

<Top> 

 

<Bottom> 
 

 

 

 

Volume 

Mode 

Mode selection 

Light 

Power 

Battery box 

Earphone outlet 

External connection outlet 
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<Size> 
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<Components> 
 
 

 

 
 

EEGfree body Earphone Connector to a PC 
   
   

  
Connector to an audio Dr.EEG Program CD User’s guide 

   
   

 

  

Battery (1.5V AAA) Case  
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How to use EEGfree 
 

 

1. Insert battery 

- Push the button on the battery case and take the cap apart 

- Put an AAA battery into the battery case 

- Close the cap 

- Its standard durability is 24 hours. 

- In case of rechargeable battery, the durability may be shorter than 8 hours. 

 

2. Connecting with earphone, audio and PC 

- Put an earphone jack into the outlet 

- When you connect an audio, connect an audio cable jack to the external 

input outlet of EEGfree. 

- You can connect either side of jack of the audio cable with EEGfree. 

- You can use not only an audio but also MP3 with EEGfree. 

- When you connect a PC, connect a computer cable jack to the external 

input outlet of EEGfree. 

 

3. Power on 

- Power will be on one second after you press power button. 

- When power is on, LED of Mode 1 on the top of EEGfree gets red light. 

- The mode 1 is set default. If you want to change a mode or turn power off, the 

mode should be initialized as the start mode. 

 

4. Mode selection 

- There is the waiting mode for 2.5 seconds after pushing power button. 

- A signal start automatically after waiting mode. 

- A mode can be changed only when the status is in the waiting mode. While 

EEGfree is in play, mode cannot be changed. 

- If you press the power button while EEGfree is playing, EEGfree will be 

converted to the state of waiting mode. 

- A mode LED blinks while EEGfree is playing. 
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5. Volume 

- You can adjust volume when EEGfree is playing. 

- We recommend you to set the lower volume if this is your first use. 

 

6. Light 

- You can adjust intensity of the light only while EEGfree is playing. 

- We recommend you to set the lower intensity of the light if this is your first use. 

 

7. Power off 

- While EEGfree is playing, convert it to the waiting mode by pressing the power 

button once and turn it off by pressing the button again, 

- EEGfree will be automatically turned off after finishing play. 
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<Index> 
 
 Chapter 1  Overview 

 Chapter 2  System requirements 

 Chapter 3  Install 

 Chapter 4  Run 

 Chapter 5  Uninstall 
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Chapter 1 Overview 

 

Dr.EEG is a program to download signals from “www.eegfree.com” to EEGfree. 

 

 

Chapter 2 OS environment 

   
Windows 98/Me/2000/XP 

CPU Intel Pentium and more recommended 
Memory 32M RAM and more recommended 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 

Appendix F.  Users Manual 

ETL Inc.  
#584, Sangwhal-ri, 
Kanam-myon, Yoju-kun,  
Kyounggi-do, 469-885, Korea 

 

13 of 26

FCC ID : P8NDFE-0203 
Report No:E02.0319.FCC.168N  
Date of Test : March 19, 2002 

DREAMFREE Inc. 
EEGfree 

Model : DFE-0203 

 

Chapter 3 Installation 

Install Dr.EEG by using CD in the package or downloading the program from 

“www.eegfree.com.” 

 

1. Click Next to start installing (Pic. 1) DrEEG.exe 

   

<Pic. 1> Start installing Dr.EEG 

 

2. Installation folder looks like <Pic. 2> and the default root is set C:\Program 

Files\Dr.EEG. To install into different directory, click Browse and select another 

directory.  

 

<Pic. 2> Choose installation directory 

 

Start installing Dr.EEG 

Click Next to continue 
or click Cancel to quit installation 

 
It is strongly recommended that you exit all 
windows programs before running installation 
program 

 
Please enter the folder where the files 
should be unpacked. 
 
If the directory does not exist, you will be 
promoted to create it 
 
Total disk space required: 10MB 

Next Cancel 

Dr.EEG Installation 

Install Cancel 

Browse 
 

Destination folder 

Dr.EEG Installation-Choose folder 
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3. If you finish to select a directory, click Install button <Pic. 2>. 

4. To quit install, click Cancel button <Pic. 3> 

 

  
 <Pic. 3> Installing program 

 

5. When installation is done, click OK button <Pic. 4>. 

  

    

 <Pic. 4> Installation completed 

 

 

 

 

Installing Dr.EEG program 

Click Cancel to quit installation 

Destination directory 
C: \Program Files\DrEEG 

Staging files 
Qtintf.dll 

Setup has finished the installation of Dr.EEG 

Cancel 

Dr.EEG Installating 

Dr.EEG Installation-completed 

Finish 



 
 
 

Appendix F.  Users Manual 

ETL Inc.  
#584, Sangwhal-ri, 
Kanam-myon, Yoju-kun,  
Kyounggi-do, 469-885, Korea 

 

15 of 26

FCC ID : P8NDFE-0203 
Report No:E02.0319.FCC.168N  
Date of Test : March 19, 2002 

DREAMFREE Inc. 
EEGfree 

Model : DFE-0203 

 

6. The executable icon and a uninstall icon will be created in 

C:\indows\Start\Program\DrEEG and installed in C\Program Files\DrEEG or the 

directory you selected. See <Pic. 5>. 

             

          <Pic. 5> Directory after installation of Dr.EEG is done 

 

7. There are installed files in the directory. See <Pic. 6>. 

   
            <Pic. 6> Installed files in the directory 

(1) Data folder :  Sound signals will be saved in this folder. If this folder is removed, 

the program will not run. Therefore, create the data folder again in DrEEG folder 

and run the program again if the data folder is missing. The default directory is 

C\Program Files\DrEEG. If you did not change the directory, just create 

C\Program Files\DrEEG\Data. 
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(2) EEGfree04.ico   :  Icon image file 

(3) iFU31A2.inf        :  Installation information file 

(4) DrEEG.exe         :  Executable file 

(5) qtintf.dll 
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Chapter 4 Start the program 

 

 4.1 Start the program 

 

1. Connect EEGfree to the serial port. 

2. Run “DrEEG.exe” in the folder or on background  

3. If EEGfree is disconnected or malfunctioned, the message shows up like <Pic 7> that 

EEGfree is not connected well. If then, check the connection first. Please make sure 

that if it is connected or not when you download signal files. 

4. If you want to create or edit library, click OK button on the message of connection 

confirmation.  

5. DrEEG shows up on the screen. 

6. To quit the program, click Exit of the “File Menu” or click Exit button on the top right 

of the page. 

 

 

<Pic. 7> Connecting EEGfree 

 

 

<Pic 8> Main screen 

 

 

EEGfree has not been connected yet. 
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4.2 Main menu 

 

1. Main menu is on the top of the main page. See <Pic. 8>. 

 

2. Copy files in data folder 

- Click Copy menu under the “Edit”menu. See <Pic. 9>. 

- Click Copy icon. See<Pic 10>.  

          
<Pic. 9> Method 1                        <Pic. 10> Method 2 

 

3. Cut files in data folder 

- Click Cut menu under the “Edit” menu. See <Pic. 11>. 

- Click Cut icon. See<Pic 12>.  

 

        

<Pic. 11> Method 1                   <Pic. 12> Method 2 

 

 

Copy 

 
Cut 
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4. Paste files in data folder 

- Click Paste menu under the “Edit” menu. See <Pic. 13>. 

- Click Paste icon. See<Pic 14>.  

 

     

<Pic. 13> Method 1                    <Pic. 14> Method 2 

5. Delete files in data folder 

- Click Delete menu under the “Edit” menu. See <Pic. 15>. 

- Click Delete icon. See<Pic 16>.  

 

      
<Pic. 15> Method 1                       <Pic. 16> Method 2 

 

 

 

 

 

 

 

 

Paste 

Delete 
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6. Add files to EEGfree modes 

- You can add files with selecting proper files and “EEG” in main menu. To add 

modes, Click “EEG,” and “Add,” and click a mode you want to add. See 

 <Pic. 17>. 

- Or click the  button to add modes. See <Pic. 18>. 

        

<Pic. 17> Method 1                       <Pic. 18> Method 2 

 

7. Delete modes in EEGfree 

- You can delete files with selecting “EEG” in main menu. To delete modes, Click 

“EEG,” point to “Delete,” and click a mode you want to delete. See <Pic. 19>. 

- Or click the  button to delete modes. See <Pic. 20>. 

 

     
<Pic. 19> Method 1                    <Pic.20> Method 2 

 

 

 

 

 
Delete Mode2 
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8. Confirm jobs 

- You can confirm jobs with selecting “Refresh” on the left window. To confirm 

jobs , Click “EEG” and click “Refresh.” See <Pic. 21>. 

- Or click the “Refresh” button to confirm jobs. See <Pic. 22>. 

 

    

<Pic. 21>Method 1                    <Pic. 22> Method 2 

 

9. Add all modes at once 

- You can add all files at once in data folder and EEGfree mode selecting 

“Move all” on the left window. To add all files at once , Click “EEG” and click 

“Move all.” See <Pic. 23>. 

- Or click the “Move all” button to add all files at once. See <Pic. 24>. 

 

     

<Pic. 23>Method 1                       <Pic. 24>Method 2 

 

Refresh 

Move all 
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10. Delete all files at once 

- You can delete all files at once in data folder and EEGfree mode selecting 

“Delete all” on the left window. To delete all files at once , Click “EEG” and 

click “Delete all.” See <Pic. 25>. 

- Or click the “Delete all” button to delete all files at once. See <Pic. 26>. 

    
<Pic. 25>Method 1                       <Pic. 26>Method 2 

 

11. Option 

- You must connect a serial port to a computer port. This is the menu to setup 

the port. The option window shows up when you click “Port” under the 

“Option” menu. 

- You can choose only one port among 4 ports (Com1 to Com 4).  

     

<Pic. 27> Port setup                      <Pic. 28> Port setup screen 

 

 

Delete all 



 
 
 

Appendix F.  Users Manual 

ETL Inc.  
#584, Sangwhal-ri, 
Kanam-myon, Yoju-kun,  
Kyounggi-do, 469-885, Korea 

 

23 of 26

FCC ID : P8NDFE-0203 
Report No:E02.0319.FCC.168N  
Date of Test : March 19, 2002 

DREAMFREE Inc. 
EEGfree 

Model : DFE-0203 

 

12. About  

- There are two menus under the “About” menu. 

- To see the information of Dr.EEG program, click “About” under the “About” 

menu<Pic. 29>. and to see www.eegfree.com, click EEGfree.com under 

“About” men, or click e icon<Pic. 31> 

   
<Pic. 29> About 

 
<Pic. 30> EEGfree.com 
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<Pic. 31> Shortcut to EEGfree.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
eegfree.com 
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Chapter 5 Uninstall program 

- To uninstall program, click “Start”menu, point to “Program,” point to DrEEG 

program group, and click “Uninstall Dr.EEG” And then you will see <Pic. 32> 

 

<Pic. 32> Confirm DrEEG uninstall 

- To uninstall the program, click “Yes,” to quit the uninstall program, click“No.” 

- While processing the uninstall program, <Pic. 33> shows up. 

 

   

<Pic. 33> Deleting 

 

- After all processes are done, DrEEG program will be removed from the 

computer. 

 

 

 

 

 

Dr.EEG is about to be removed from this 
computer 
 
Do you wish to continue? 

Removing files 

File 
 
Folder 

Shortcut icon 
 
Registry 

INI 

Yes 
 

No 

Uninstalling Dr.EEG 

Removing Dr.EEG 

Cancel 
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For a class B digital device or peripheral, the instructions furnished the user shall include the following or similar 
statement, placed in a prominent location in the text of the manual. 

Note: This equipment has been tested and found to comply with the limit for a Class B digital device, 
pursuant to part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions. If this equipment does cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. IF 
this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encourage to try to correct the interference by one or the 
following measures: 
 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
- Consult the dealer or an experience radio TV technician for help. 

 

Change or modification not expressly approved by the party responsible for Compliance could void the 
user’s authority to operate the equipment. 
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